Troubleshooting
Word 2000
I

Many users rely heavily
on Word, and don’t
welcome system crashes,
corrupted documents or
go-slow software. We
explain some of the
simple steps you can take
to rectify these problems.

f your company uses Microsoft Word 2000, you probably get your share of
users’ problems to resolve. You might have users for whom Word stubbornly
refuses to load, or whose documents seem unusually prone to corruption. Or
you might find that users complain about the program’s performance, or experience an unreasonable number of crashes. It’s not that Word is particularly buggy
- far from it. But, for many people, the word processor is their most critical tool,
and any minor problem is likely to set the phones ringing at the helpdesk.

By Mike Lewis
Technical Journalist

Service Packs

Fortunately, most Word 2000 problems can be fixed fairly easily, provided you
approach them in a systematic way. In this article, we’ll look at the most common
difficulties you are likely to encounter and discuss ways of overcoming them. I’ll
also give you some tips for improving the program’s performance. The article will
focus on Word 2000, but many of the techniques will also work with Word 97.

The first thing you should do - preferably before a user reports a problem - is to
make sure that your deployed copies of Word are up to date. At the time of
writing, over a hundred bugs have been reported in Word 2000, the majority of
which have been corrected with service releases. So far, Microsoft has issued two
service packs for the Office 2000 suite. SR-1 fixes around 70 Word-related bugs you’ll find a list of them in KnowledgeBase article Q245021. You’ll find the SR-1
file (actually the second release of it, known as 1a) on your PCSA CD in the
Resource Files section. See the box below for details of how to find out whether
SR-1 is installed.
Microsoft has also issued a number of smaller patches, covering bugs and security
vulnerabilities that were not corrected in SR-1. As far as Word is concerned these
address the following issues: a vulnerability in the Office 2000 UA Control (used
in the Show Me function in HTML Help); a security update for WordMail (ie,
when using Word as an editor in Outlook); a problem with HTML Help when
displaying non-English text; and a vulnerability affecting certain uses of HTML
within Office applications. KnowledgeBase article Q266134 has full details of
these patches.
Of course, more bugs will come to light, and more service packs and patches will
be issued during the life of Office 2000. To make sure you are always up to date,
it’s worth keeping an eye on Microsoft’s Office Update site (officeupdate.microsoft.com). This site also lets you sign up for a useful notification service which
will automatically inform you of Office updates by email.
Service Pack 2 for Office 2000 was released recently and fixes a few more bugs. It
also has a major impact on Outlook, as it attempts to improve virus protection by
preventing users from opening many forms of attachments. [We recommend that
you don’t installed SR-2 until you have read our article on the subject, which will be
published shortly - Ed].

Word Fails To Start
Let’s turn now to some of the specific problems that you might be asked to deal
with. One of the more common of these is that Word either fails to start or crashes
immediately after loading. A likely cause for this is a problem with one of the
templates or add-ins that are automatically loaded at startup. Another possible
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reason is that a certain registry key - one which holds Word configuration settings
- has become corrupted. You can verify these by starting Word from the Run
dialog, with /a appended to the command line. This will launch Word with
default settings, bypassing any global templates and add-ins and the relevant
registry key. If you succeed in loading Word in this way, you can now start
eliminating the possible causes until you identify the culprit.
Start by exiting Word, then renaming NORMAL.DOT (this is usually stored in
the Application Data\Microsoft\Office directory). Now launch Word again, this
time without the /a switch. If Word starts properly, then NORMAL.DOT is the
source of the problem. At this point, Word will have created a new NORMAL.DOT, containing default settings. Using the Organizer window (which you
access from the Templates and Add-ins dialog on the Tools menu), you can
selectively copy styles, AutoText entries, macros and other customisations from
the original NORMAL.DOT (the one you renamed) to the new one. Try to re-start
Word after transferring each entry; if the problem comes back, you will have
pinpointed the cause of the trouble and can thus eliminate it.
If NORMAL.DOT is not the guilty party, try eliminating any other global templates and add-ins. These are files with the extensions DOT (templates) and WLL
(add-ins), stored in Word’s Startup directory (usually Application Data\Microsoft\Word\Startup). Start by moving all such files to another directory, then
launch Word without the /a switch. If Word loads happily, exit the program, then
copy back each of the templates and add-ins in turn, re-starting Word each time
until the problem comes back. This will tell you which file caused the problem.
You can then either re-install the file from its original source, recreate it, or manage
without it.
If this doesn’t solve the problem, the next place to look is the registry key which
holds certain Word customisation settings. Open RegEdit and navigate to
HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Word\Data. Using
the Export registry command on the registry menu, save this entry in a backup
file (make sure that the Selected Branch option is enabled in the Save dialog).
When you are happy that this has worked, go ahead and delete the key. Next,
launch Word (again, without the /a switch). If it now runs properly, then it was
the registry key that caused the crash. At this point, you will have lost some of
your customisations and settings, including your toolbar and menu configurations, but at least you will be up and running. If Word still doesn’t load and you
want to restore the deleted key, use the Import Registry File command (within
RegEdit) to reload the key from the backup.
One last possible culprit - albeit an unlikely one - is the Tahoma font file that comes
with Office 2000. If this has become corrupted, it could cause Word to crash at
startup. If you suspect this to be the case, install a fresh copy from the Office CD,

“As a last resort,
save the document as
a text-only file. You
will lose all your
formatting, but at
least the text will
be safe.”
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or copy it from another computer. If all else fails, try running the Office 2000 Detect
And Repair utility. You can access this from the Help menu in any Office
application, or by running Office Setup in maintenance mode. If that doesn’t do
the trick, your final recourse will be to re-install Word.

System Errors
Even when the user can launch Word successfully, problems might still occur
while the program is being used. If the user experiences frequent system errors,
such as invalid page faults or illegal operations, there are a number of steps you
can take to track down the cause. The first thing to do is to click on the Details
button within the error dialog so that you can see which module caused the
problem. If the module is part of Office or Word, it’s worth running Detect And
Repair in case the file in question has become corrupted. How do you find out if
the module belongs to Office or Word? One way is to consult Microsoft’s DLL
Help Database, which you can access from msdn.microsoft.com.
If the system consistently crashes while you are editing or printing a document,
it could be that either the printer driver or video driver is damaged. A corrupted
driver is very likely to cause invalid page faults or other system errors (this is true
of the printer driver even if no printing is taking place). To verify this, try
eliminating each of the two drivers in turn. To check the printer driver, select a
different default printer, and try to reproduce the error. Because many printer
drivers are based on common core drivers, it is best to select a completely different
type of printer, such as a PostScript printer if the original driver was non-PostScript, and vice versa. Remember, you don’t actually need to connect the printer
in order to install its driver. Similarly, to eliminate the video driver, select a
standard driver such as “Standard Display Adapter (VGA)”, and try to reproduce
the error. To change the video driver, go to the Settings tab of the Display property
sheet and click on Advanced Properties. If eliminating each driver in turn leads
you to believe that either the printer driver or video driver is at fault, re-install
the offending component from its original source, or contact the vendor for an
updated version.

Other Damaged Files
There are several other files which, if damaged, could cause unexpected problems. They include custom dictionaries, AutoCorrect files, spelling and grammar
files, and fonts. These files are accessed frequently during editing, especially if
background grammar-checking or spell-checking is enabled. As always, your
approach should be to eliminate each of the potential offenders in turn until you
have identified the troublemaker.
To eliminate the custom dictionaries, search for files with the extension DIC; they
are usually stored in the Application Data\Microsoft\Proof directory. Move

“Click on the Details
button within the
error dialog so that
you can see which
module caused the
problem.”
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these to another directory, then try to reproduce the error. If this succeeds in
correcting the problem, you will now have a new custom dictionary without any
words in it. Fortunately, custom dictionaries are ordinary text files, so it is quite
easy to restore their contents. Try opening the original dictionary in a text editor,
then looking for any obvious garbage. Delete this, and copy the file back to the
appropriate directory. Alternatively, open the original dictionary as a document
within Word, then spell-check it, adding all the erroneous words to the new
dictionary.
You can take a similar approach with AutoCorrect files. These are files with the
extensions ACL, usually stored in the Application Data\Microsoft\Office directory. Again, move these to a different directory (but be careful not to move
MSO1033.ACL, MSO2057.ACL or MSO3081.ACL, as these contain settings required by the system). Unfortunately, there is no way of recovering user entries
from corrupted AutoCorrect files, so if this turns out to be the problem, you will
lose your existing entries.
The easiest way to eliminate grammar and spelling files, however, is to switch off
background grammar-checking and spell-checking (you do this from the Spelling
And Grammar tab in the Options dialog). If the problem goes away, run Detect
And Repair to re-install the offending files.
If none of the above proves fruitful, the problem might be caused by a corrupted
font. Fortunately, you won’t have to progressively uninstall every font in the
system - only the ones actually used in the document which the user was editing
when the crash occurred. To uninstall a font, simply move it out of the Fonts folder
to a temporary location.

Corrupted Documents
Another possible reason for crashes is a corrupted document. If a user reports
that Word misbehaves whenever a particular document is open, there are several
avenues for you to explore. A good first step is to try to reproduce the behaviour

Checking For SR-1
To check whether a given
computer has SR-1 or SR1/1a installed, look for
“Microsoft Word 2000
(9.0.3821 SR-1)” at the top
of the About box within
Word. However, even this
simple bit of functionality
is not entirely bug-free. If
you installed another Office application - say, Excel
2000 - then updated it to
SR-1, then later installed
the original version of
Word 2000, the About box
will incorrectly show that
Word is now at SR-1. Fortunately, the System Info
window (which you can
access from the About box)
will show the correct details.
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by opening the same document on another computer. If this does not reproduce
the problem then the document is probably not to blame and you will need to
look elsewhere. You should also try eliminating any template attached to the
document. Check to see if the problem persists after you have removed the
template or, alternatively, see if the same template causes similar difficulties when
attached to other documents.
If these steps lead you to believe that the document itself is corrupted, it is
probably best to discard it - but only after you have salvaged as much of its
contents as possible. A good way to do that is to save the document as RTF. When
you do so, Word will ignore any content which it doesn’t understand, so this
should get rid of the corruption while keeping virtually all the text, formatting
and graphics intact. An alternative approach is to paste the entire text into a new
document, but without the final paragraph mark. In this case, you will lose some
of your formatting, including the document’s styles and the layout of the final
section, but, with luck, the corrupted areas will be left behind as well. If the new
document appears to behave properly, you can discard the original.
If you can actually see the corruption within the text - as a block of garbage
characters, perhaps - you could try copying the undamaged portions to a fresh
document. Leave behind the corrupted area, including all its paragraph marks.
This should enable you to rescue part of the document, although you will have
to re-enter and re-format the sections that were damaged. As a last resort, save
the document as a text-only file. You will lose all your formatting, not to mention
embedded graphics, macros and the like, but at least the text will be safe. You
might also be able to combine this approach with the previous one. Copy the
undamaged portions to a new document, save the original document as text-only,
and then copy any missing text from the text file to the new document.

Document Which Won’t Open
In the steps described above, we have assumed that you can at least open the
corrupted document. Sometimes, a document is so badly damaged that it refuses
to open. Worse, it might cause Word to crash whenever you try to open it. But,
even here, there are ways of dealing with the problem.
One possibility is to insert the problem document into a new document (do this
by selecting File from the Insert menu). If this works, you can go ahead and save
the new document and discard the old one. Most of your text and formatting
should be intact, except that the final paragraph mark will not have been inserted,
so you will again lose the document’s styles and the layout of the final section. If
this technique does not work, try opening the document in draft mode (to do so,
select Draft Font from the View page of the Options dialog; do this before you
open the document). If this succeeds, you should be able to save the file in the
usual way, then re-open it as normal. If you can’t do that, copy the entire text
(minus the final paragraph mark) to a new document, or save the document as
RTF. Either way, the text and most of the formatting should be preserved.
Another possible approach is to try to open the document using the Recover Text
Converter. You do this by selecting Recover Text From Any File in the Files Of
Type control in the Open dialog. However, if the document cannot be opened in
the normal way, it is likely that the Recover Text Converter will not be able to
open it either. If you do succeed in opening it, you should be able to salvage the
entire text, but not the formatting, graphics etc.

“To eliminate the
custom dictionaries,
search for files with
the extension DIC.”
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One final possibility is to remove the document’s “signature”. This will fool Word
into thinking that it is a plain text file, which it will then happily open. Start by
opening the document in a text editor, such as Notepad. You will see a block of
what looks like garbage characters at the start and the end of the file, with the
document’s text - all strung out as one long paragraph - in the middle. Delete the
first eight characters from the file, then save it under a new name. Now, open this
new file in Word. You will still see some garbage, but this can now be safely
deleted. With luck, you will also see all the original text, including headers, footer,
footnotes and the like. But the formatting and graphics will again be lost.
With these last two techniques, your chances of success will be higher if the user
had switched off the Allow Fast Saves option (on the Save tab of the Options
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dialog). When this option is enabled, Word will add any new text to the end of
the file when saving. This tends to speed up saving, but it also fragments the text,
making it harder to recover.

AutoRecover
If a user experiences frequent crashes in Word, it might be worth enabling the
AutoRecover option. With this option in force, Word will periodically save a
“recovery” file, this being essentially a snapshot of the current document. If the
program later fails to shut down properly while there are unsaved documents
open, the recovery file can be used to restore most or all of the document’s
contents. Note that you cannot use this technique retrospectively; it only works
if you enable AutoRecover before the problem occurs.
To enable AutoRecover, select the “Save AutoRecover info every...” option on the
Save tab of the Options dialog, and specify a suitable interval in minutes (the
default is 10). From now on, Word will periodically save the AutoRecover file.
This file will remain on the hard disk until the original document is properly saved
(or explicitly closed without saving). If the AutoRecover file still exists the next
time you launch Word, it follows that the document was not correctly saved in
the previous session, so Word will try to open the recovery file instead. In general,
all this goes on behind the scenes, without any action on the part of the user.

Performance Issues
To conclude the article, we’ll look at some ways of improving Word’s performance. For the most part, Word will run at an acceptable speed provided it is given
adequate hardware. Officially, the minimum requirement is a 75 MHz Pentium
with 20 MB of RAM under Windows 95/98, or 36 MB under NT or Windows 2000.
In practice, you will need to add about 16 to 24 MB of RAM to those figures to
achieve reasonable performance. If users do complain that Word is running
slowly, first consider the usual ways of optimising Windows: defragging the hard
drive, ensuring that the paging file is on the fastest available drive, storing
document files locally rather than on a server, eliminating wallpaper, switching
to a lower colour resolution, reducing the number of fonts, and so forth.
Within Word, one of the most effective ways of improving performance is to
switch off the various background activities. These include spell-checking and
grammar-checking, and all the options on the AutoCorrect and AutoFormat As
You Type tabs of the AutoCorrect dialog. These tasks require quite a lot of
processing, and you will notice a definite increase in speed if you can manage
without them, especially where memory is low. Another tip is to edit the document in Normal view rather than Print Layout view wherever possible. If the
document contains a lot of images, consider also enabling the Picture Placeholders
option (from the View tab in the Options dialog). This causes graphics to display
as empty boxes, which greatly speeds up scrolling. Setting the Draft Font option
(on the same tab) will also give a noticeable improvement.

“Unfortunately,
SR-1 introduced a
few new bugs of its
own, so Microsoft
was forced to issue
another patch soon
after its release.”

Finally, if the user has Outlook 2000 installed, check the option which automatically tracks Word documents in the journal (to do so, select Options from the
Tools menu in Outlook, then click on the Journal Options button). This option
tends to slow down the closing and saving of files within Word, so it is worth
switching it off if you don’t need it.

Conclusion
As I mentioned at the outset, Word 2000 is not a particularly troublesome
application, but it is one that users tend to rely on heavily. By familiarising
yourself with the techniques which I have described, you will be well placed to
deal with any problems that come your way.
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